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KNK Zing / Zing Air con Make The Cut1 
 

6 de octubre de 2017 
 
 
Este manual es basado en Make The Cut (MTC), versión 4.6.1. Debido a las actualizaciones regulares de MTC, 
le recomendamos no imprimir todo este documento, sino leerlo en la pantalla o imprimir sólo aquellas páginas 
que necesite en un momento dado. 
 
 
 
 

Donde Comenzar 

• Gracias por elegir una cortadora de troquel digital Klic-N-Kut. Antes de usar una cuchilla en su nueva 
cortadora, le sugerimos que lea los capítulos 1 y 2 y vea los videos proporcionados a través de enlaces en 
estos dos capítulos. 

• Si usted tiene problemas con el funcionamiento de la KNK, apague la alimentación y busque una solución 
en este manual. Tenga en cuenta que el apéndice B es una sección de solución de problemas. Si continúa 
teniendo preguntas o problemas técnicos, póngase en contacto con su proveedor de KNK Zing lo antes 
posible. 

• Para ayuda adicional, visite nuestro grupo de Yahoo en: http://groups.yahoo.com/group/KNK_Zing/ y 
nuestro foro de apoyo en: http://knkusa.com/forums/. 

• Joe Rotella, propietario de Create & Craft, creó un excelente video de una hora para los nuevos 
propietarios de KNK Zings:  

 

 

____________________________________________________ 
 © 2011, 2012, 2013, 2014 Accugraphic Sales, Inc., All Rights Reserved 
 
  

http://groups.yahoo.com/group/KNK_Zing/
http://knkusa.com/forums/
http://www.createncraft.com/
http://www.youtube.com/watch?v=kz8QsGZbDjg
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9. Impresión y Corte 
 
 
 
 

9.01 Que es una Impresión y Corte (PNC)? 

 

• El proceso de impresión y corte implica la impresión de una imagen desde MTC a cualquier impresora que 
usted posea y, luego, con la ayuda del láser de la Zing, cortar la imagen o las imágenes con una precisión 
perfecta. A continuación, se presentan tres tipos típicos de aplicaciones de impresión y corte, pero hay 
otros tipos. Asegúrese verificar la Sección 9.06 y 9.07: 

• Recortar los bordes reales de la imagen impresa(s): 

     

 

• Cortes fuera de los bordes, pero siguiendo las formas de la imagen impresa(s): 

    

 

• Los cortes siguen una figura diferente a la de la imagen impresa(s): 

      
 
 
 

9.02 ¿Qué es una calibración PNC? 

• Para obtener resultados precisos de Impresión y corte, usted debe ajustar la calibración del 
Desplazamiento del Láser (Laser Offset). Esto no es nada más que determinar qué tan lejos está la luz 
láser en su KNK en relación con la punta de la cuchilla. Debido a que el láser es instalado manualmente en 
un pequeño orificio dentro del carro de la cuchilla, la distancia de la luz láser a la punta de la cuchilla variará 
de un Zing a la otra. También, usted deseará utilizar el mismo porta-cuchilla con todas sus aplicaciones de 

La imagen es cortada con 
precisión a lo largo de los 
bordes impresos 
 

La imagen es cortada en la 
misma forma, pero se 
desliza fuera de los bordes 
impresos 

Una figura personalizada es 
cortada alrededor de la 
imagen impresa. 

http://www.youtube.com/watch?v=VN_mPhc9Ajs
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PNC, ya que la distancia también puede cambiar con sostenedores más grandes o más pequeños en 
diámetro. 

• La distancia es medida en mm en una dirección X y en una dirección Y: 

 

 

 

• Esta calibración sólo necesita realizarse una vez, para un portacuchillas dado y, luego, usted puede grabar 
esta calibración en caso de que usted necesite instalar MTC en una nueva computadora o que usted tenga 
que reformatear el disco duro de su computadora actual. Las unidades son en mm ya que son más fáciles 
de medir en distancias muy pequeñas.  

• El complemento Zing tiene un conjunto de números de calibración predeterminados que estarán cerca de 
los números finales, pero no exactamente iguales. Para acceder a estos números, haga clic en el pequeño 
icono de llave inglesa que se indica a continuación y se abrirá la ventana Calibrate (Calibrar): 

 

 

      

• El proceso implica realizar y repetir una impresión y corte (PNC) para ver cuánto usted necesita ajustar los 
valores X e Y para obtener resultados perfectos. Y usted DEBE ser capaz de obtener PNC perfecto!  : ) 

 
 

9.03 Procedimiento PNC Parte 1: Configuración e impresión  

• ¿Qué usted necesita antes de comenzar un PNC? 

 En primer lugar, usted necesita una imagen para imprimir, una impresora y el portacuchillas que usted 
planea utilizar para todos los PNC. El diámetro del portacuchillas afectará la calibración del láser. Nota: 
Si usted está importando una imagen para ser usada, consulte el Capítulo 6 para obtener detalles 
sobre el proceso de seguimiento de píxeles. 

 ¡Usted necesita estar bien descansado! Usted No querrá comenzar a aprender el proceso de PNC 
cuando está cansado, estresado o con prisa. Dominar un PNC viene cuando usted tiene el tiempo de 
repetirlo cerca de 4 veces corrido. En ese momento, usted no sólo habrá repetido el proceso suficientes 
veces para sentirse muy cómodo con el orden de los pasos, pero usted tendrá la calibración 
perfeccionada y estará listo para hacer las PNC futuras con rapidez y facilidad. 

 
 
 

 

Haga clic en la llave para abrir la 
ventana de calibración 
 

Laser Offset 

IMPORTANTE: No utilice velocidades altas al realizar PNCs muy precisos, incluyendo la siguiente 
calibración. Ajuste ambas velocidades Cut y Up Speeds a 11 (utilice 9 en la Zing original).    

X Offset 
(Desplazamiento X) 

Y Offset (Desplazamiento Y) 

Punto láser 
Punta de la 
Cuchilla 



 5 

• Si bien es posible hacer PNC en modo vertical o horizontal, es muy recomendable que usted seleccione la 
misma orientación que usted suele utilizar para su otro corte en MTC. Si usted prefiere trabajar en modo 
vertical, por favor vaya a la sección Portrait Mode Option (Opción de modo Retrato). 

Opción de Modo de Paisaje 

• Para comenzar, cree un tapete nuevo personalizado que esté configurado para tamaño carta o A4 o 
cualquier tamaño que vaya a ser su impresión. Consulte la Sección 3.04 si usted necesita instrucciones 
para crear un tapete personalizado. Desactive el cuadro Margins (Márgenes). Para el tamaño carta, haga 
el Ancho 11" y la Altura 8.5". Para A4, ajuste el Ancho a 11.69" y la Altura a 8.27".  

• Puesto que usted está leyendo la sección Opción de modo de Paisaje del manual del usuario, ajuste el 
tapete virtual a Landscape (Paisaje) y seleccione su nuevo tapete personalizado. 

• ¿Cuál es la mejor imagen para usar para la calibración de Laser Offset (desplazamiento láser)? Una flecha 
es ideal porque usted podrá verificar rápidamente si usted tiene la impresión correctamente colocada en el 
tapete de corte. Además, es una gran figura para ver cómo ajustar los números de calibración X e Y. Usted 
puede utilizar casi cualquier imagen, pero para seguir el resto del tutorial con mayor facilidad, se 
recomienda una flecha de la biblioteca de Basic Shapes (Figuras básicas): 

 

  

• Observe que la flecha apunta hacia arriba en la pantalla. ¡Asegúrese de que su flecha también está 
apuntando hacia arriba! Posteriormente, cuando usted imprima la flecha y coloque el papel en el tapete, la 
flecha estará apuntando a la derecha al usted insertar el tapete en la Zing. 

• Luego, vaya a File>Print Setup, seleccione la impresora que usted va a utlizar, y ajuste la Orientación a 
Paisaje (Orientation a Landscape): 

 

• Luego, vaya a File>Print Options y marque los siguientes cuadros: 

Escoja 
Landscape 

Las dimensiones del 
tapete deben coincidir 
con la impresión 

Importe una flecha y 
girela hacia arriba 

Seleccione 
(Paisaje)Landscape 

Seleccione su 
impresora 

Haga clic en Aceptar (OK) 
cuando haya terminado 

Verifique el 
tamaño del papel 

IMPORTANTE: Haga que la flecha tenga al menos 6" de alto (como se muestra a 
continuación) para una calibración precisa. 
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• Después de hacer clic en Aceptar, usted debe ver los bordes verdes en el Tapete Virtual, indicando cómo 
la impresió será ubicada en el tapete y donde la flecha será impresa. Si la flecha está fuera de los bordes 
verdes, muévala de modo que caiga dentro de los límites: 

  

• Vaya a File>Print Preview y usted podrá ver la flecha más las cuatro marcas de registro que deben 
alinearse con los límites de la flecha: 

                  

Aquí se muestra 
información sobre la 
configuración actual de su 
impresora. 

Las líneas punteadas en 
verde indican la parte de 
la pantalla que se 
imprimirá 
. 

Clic aquí para 
imprimir 

Verifique cuidadosamente 
esta vista previa. 
 
¿Ve usted las cuatro marcas 
de registro? (las flechas 
rojas señalan las 4 marcas 
de registro) 
 
¿Conseguirá usted lo que 
usted necesita impreso?  
 
(Tenga en cuenta que la 
opción Wireframe se 
desactivó para esta captura 
de pantalla para que la 
imagen se pudiera ver más 
claramente en este tutorial). 

Cuatro marcas de 
registro deben 
aparecer en las 
esquinas del cuadro 
delimitador 
. 

Haga clic en Aceptar (OK) 
cuando haya terminado 

Marque esta opción si usted 
desea sólo un contorno de la 
flecha impresa (¡para ahorrar 
tinta!) 

Marque estas tres casillas 

Opción para cambiar el color del contorno 
de la imagen 

Establezca en 0, ya que 
esto no aplica a los 
cortadores KNK 
. 
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• Siempre asegúrese de poder ver las cuatro marcas de registro antes de continuar ya que son parte integral 
del proceso PNC. Si su vista previa de impresión coincide con la anterior y ve las cuatro marcas, haga clic 
en el botón Imprimir (Print). También verifique que lo que se está imprimiendo es lo que usted necesita. 
Por ejemplo, usted pudo haber añadido una figura adicional para cortar, pero usted no desea que esta 
aparezca en la impresión. Aquí es donde usted querrá utilizar la función de Capas para controlar lo que se 
imprimirá, así como que será cortado más tarde. 

• Es posible que usted desee imprimir varias (4 o 5) copias, ya que usted deseará repetir este proceso varias 
veces para obtener los ajustes de calibración perfectos. 

• Después de imprimir, coloque la impresión en el tapete. Como usted se encuentra de frente a la Zing, la 
impresión debe estar en el tapete en una orientación vertical con la flecha apuntando hacia la tapa final 
derecha de la máquina: 

 

• ¡Vaya a la Sección 9.04 para continuar con los siguientes pasos! 
 
 

Opción de Modo Retrato 

• Para comenzar, cree un nuevo tapete personalizado que esté configurado para tamaño de carta o A4 o 
cualquier tamaño que tenga su impresión. Consulte la Sección 3.04 si usted necesita instrucciones para 
crear un tapete personalizado. Desactive el cuadro Margins (Márgenes). Para el tamaño carta, haga el 
Ancho 11" y la Altura 8.5". Para A4, ajuste el Ancho a 11.69" y la Altura a 8.27".  

• Ya que usted está leyendo la sección Opción de modo Retrato del manual del usuario, ajuste el tapete 
virtual a Portrait (Retrato) y seleccione su nuevo tapete personalizado. 

• ¿Cuál es la mejor imagen para usar para la calibración de Laser Offset (desplazamiento láser)? Una flecha 
es ideal porque usted podrá verificar rápidamente si usted tiene la impresión correctamente colocada en el 
tapete de corte. Además, es una gran figura para ver cómo ajustar los números de calibración X e Y. Usted 
puede utilizar casi cualquier imagen, pero para seguir el resto del tutorial con mayor facilidad, se 
recomienda una flecha de la biblioteca de Basic Shapes (Figuras básicas): 

 

¡Fije el origen en la esquina 
inferior derecha de la 
impresión, utilizando el 
láser! 

Coloque su impresión en 
el tapete de corte en 
esta orientación 
. 

Introduzca el 
tapete en esta 
dirección en la 
Zing 

IMPORTANTE: Haga que la flecha tenga al menos 6" de alto (como se muestra a 
continuación) para una calibración precisa. 
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• Observe que la flecha está apuntando hacia la derecha en la pantalla. ¡Asegúrese de que su flecha también 
apunta a la derecha!   

• Luego, vaya a File>Print Setup, seleccione la impresora a usar, y establezca Orientation a Portrait: 

 

• Luego, vaya a File>Print Options y marque las siguientes casillas: 

  

 

• Después de hacer clic en OK (Aceptar), usted debe ver los bordes verdes en el tapete virtual, indicando 
cómo la impresión será ubicada en el tapete y donde la flecha será impresa. Si la flecha está fuera de los 
bordes verdes, muévala de modo que caiga dentro de los límites: 

Seleccione 
Portrait 

Las dimensiones del 
tapete deben coincidir 
con la impresión 
 

Importe una flecha y 
compruebe que esté 
orientada hacia la 
derecha 

Seleccione Portrait 

Seleccione su 
impresora 

Haga clic en OK cuando 
haya terminado 

Verifique el 
tamaño del papel 

Click on OK when done 

Marque esta opción si usted 
desea sólo un contorno de la 
flecha impresa (¡para ahorrar 
en tinta!) 
 

Marque estas tres opciones 

 
Opción para cambiar el color del contorno 
de la imagen 

Establezca en 0, ya que 
esto no aplica a las 
cortadoras KNK. 
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• Vaya a File>Print Preview y usted podrá ver la flecha más las cuatro marcas de registro que deben estar 
alineadas con los límites de la flecha: 

            

• Siempre asegúrese de que sted puede ver esas marcas de registro antes de continuar ya que son parte 
integral del proceso PNC. Si su vista previa de impresión coincide con la anterior y ve las cuatro marcas, 
haga clic en el botón Print (Imprimir). También verifique que lo que se está imprimiendo es lo que usted 
necesita. Por ejemplo, usted pudo que haya añadido una figura adicional para cortar, pero usted no desea 
que aparezca en la impresión. Aquí es donde usted querrá utilizar la función de Capas para controlar lo que 
se imprimirá, así como lo que será cortado más tarde. 

Aquí se muestra información 
sobre la configuración actual de 
su impresora. 

Las líneas punteadas en verde 
indican la parte de la pantalla que se 
imprimirá. 

Haga clic aquí para imprimir. 

Verifique cuidadosamente 
esta vista previa. 
 
¿Ve usted las cuatro marcas 
de registro? (las flechas 
rojas señalan las 4 marcas 
de registro) 
 
¿Conseguirá usted lo que 
usted necesita impreso?  
 
(Tenga en cuenta que la 
opción Wireframe se 
desactivó para esta captura 
de pantalla para que la 
imagen se pudiera ver más 
claramente en este tutorial). 
 

Cuatro marcas de 
registro deben 
aparecer en las 
esquinas del cuadro 

delimitador. 
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• Es posible que usted desee imprimir varias (4 o 5) copias, ya que usted deseará repetir este proceso varias 
veces para obtener los ajustes de calibración perfectos. 

• Después de imprimir, coloque la impresión en el tapete, en la misma orientación que ve en la ventana 
principal e inserte el tapete en la Zing. Como usted se encuentra de frente a la Zing, la impresión debe 
estar en el tapete en una orientación vertical con la flecha apuntando hacia la tapa final derecha de la 
máquina: 

 

 
 

9.04 Procedimiento PNC Parte 2: Alineación y Calibración 
 

Alineación del Láser con las Marcas de Registro 

• Haga clic en el icono Cut Project With para ir a la ventana de corte. Si usted aún no ha realizado un corte 
de prueba, hágalo ahora utilizando el ajuste Knife Point (punto de cuchillo) o WYSIWYG. Realice el corte 
de prueba en un lugar que no sea parte de su corte final o utilice un desecho del mismo material que usted 
está cortando. 

• Después de que el corte de prueba tenga éxito, haga clic en la ventana Set Blade Origin. Mueva la luz 
láser hasta que esté directamente sobre la esquina inferior derecha de la impresión, como se indicó 
anteriormente. Haga clic en Finished para establecer el origen. 

• En Cut Type (Tipo de corte), seleccione Print And Cut (Imprimir y cortar). También establece sus 
velocidades de Cut (corte) y Up Speeds (subida) a 11 (9 en Zing original). Con el fin de obtener resultados 
PNC perfectos y repetibles, usted debe asegurarse de que no está moviendo el tapete de corte demasiado 
rápido a través de la cuchilla. Además, yo no uso la guía del tapete del lado izquierdo durante impresiones 
y cortes (PNC). Por lo tanto, afloje ese poste y deslícelo a la extrema izquierda, fuera del camino. 

• Haga clic en Cut Project y el láser se moverá automáticamente a una distancia muy corta de la primera 
marca de registro. Se abrirá la siguiente ventana: 

 

 

¡Fije el origen en la esquina 
inferior derecha de la 
impresión, utilizando el 
láser! 

Coloque su 
impresión en el 
tapete de corte en 
esta orientación. 

Introduzca el 
tapete en esta 
dirección en la 
Zing 

Este punto parpadeará en 
rojo. 
 
Tenga en cuenta la 
orientación de esta 
pantalla en relación con su 
impresión en el tapete. 
Esta será la marca de la 
parte superior derecha 
cuando se enfrente a la 
KNK porque su flecha 
debe apuntar a la derecha. 
 

Controla el tamaño del paso para cada movimiento de la tecla de 
flecha 
 

Haga clic en Next (o presione 
la tecla Enter) después de 
mover el láser a la esquina de 
la marca de registro 
 

Haga clic en las flechas 
para mover la luz láser 
(o use las flechas en el 
teclado) 
 

IMPORTANTE:  Ajuste las velocidades de 
Corte y Subida a 11 (9 en Zing original) 
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• Asegúrese de que el láser se haya movido a una pulgada o menos de la marca de registro indicada por el 
punto rojo parpadeante mostrado arriba. Si no es así, usted deseará revisar los pasos que usted ha 
utilizado hasta ahora para asegurarse de que usted tiene todas las mismas configuraciones mostradas y 
que usted tiene su impresión en el tapete en la misma orientación que se mostró anteriormente. 

• El siguiente paso es mover el punto láser de modo que esté precisamente en la esquina de la marca de 
registro impresa. Esta ventana es muy similar a la ventana Set Blade Origin. Haga clic en las teclas de 
flecha de la pantalla o utilice las teclas de flecha del teclado. Importante: una vez que usted esté cerca de la 
marca, disminuya el ajuste Move By (Mover por) a 4 para que tenga un control preciso de la alineación. 
Una vez que el punto láser está en lugar, haga clic en Next (Siguiente) o presione la tecla Enter.   

 

• El láser se moverá hasta la proximidad de la siguiente marca de registro y la luz roja parpadeante en el 
programa se moverá al mismo punto relativo: 

 

 

 

 

• Repita el proceso con la marca de registro final: 

 

 

 

• Después de hacer clic en Finished, se abrirá la siguiente ventana y le recordará que usted debe esperar 
hasta que el corte haya terminado antes de volver a la ventana Cut with Klic-N-Kut Zing: 

Este punto ahora estará parpadeando en rojo 
 

Una vez más, haga clic 
en estas flechas o sus 
flechas del teclado hasta 
que el punto del laser 
esté encima de la marca 
del registro. 

Una vez que la luz esté 
centrada en el punto de 
la marca reg, haga clic 
en Next o presione la 
tecla Enter 
. 

Este punto ahora 
estará parpadeando 
en rojo 
 

Mueva la luz láser hasta el 
punto del punto impreso. 

Otra vez, haga clic en 
estas flechas o sus 
flechas del teclado hasta 
que el punto del laser 
esté encima de la marca 
de registro. 

Una vez que la luz esté 
centrada en el punto de 
registro, haga clic en 
Finished o presione la 
tecla Enter 

Usted notará que la intensidad de la 
luz láser cambiará cuando esté 
encima de las líneas negras 
impresas. ¡Esto puede ser muy útil! 
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• Una vez que usted haga clic en OK (Aceptar), la figura de la flecha se cortará.  
 
 

Ajuste del Desplazamiento (offset) del Láser 

• Una vez finalizada la impresión y corte, examine dónde se hicieron las líneas de corte con respecto a las 
líneas impresas. Si el desplazamiento es lo suficientemente grande, utilice una regla de mm para medir. Si 
el desplazamiento es muy pequeño, entonces la estimación estará bien a medida que usted perfecciona su 
calibración. 

• En el siguiente diagrama, las líneas rojas representan las líneas de corte y las líneas negras representan 
las líneas impresas. Utilice este diagrama para determinar si sus valores de Desplazamiento deben 
elevarse o bajarse para su láser: 

 

 

 

                               

 

 

 
 

 

• Modifique sus valores de desplazamiento (Offset) X e Y en la ventana que se muestra al final de la Sección 
9.02. Comience con ajustes de 1 mm (como se muestra arriba). Cuando introduzca un número inferior a 1, 
recuerde incluir un 0. Por ejemplo, no introduzca ".4". Introduzca "0.4". 

• Es una buena idea mantener un seguimiento de los valores anteriores, para que usted pueda saber qué 
dirección cambiar para las pruebas de calibración posteriores. Recuerde que usted debe esperar obtener 
resultados perfectos, así que siga ajustando los valores de X e Y hasta que usted llegue allí. Después de 
ajustar por 1 mm, usted tendrá que ajustar por 0.5 mm y aún más pequeño para que sea perfecto. 

• Usted puede encontrar que un lado está alineado pero el otro no. Por ejemplo, la línea de corte puede estar 
perfectamente alineada con la línea de impresión en el lado inferior de la flecha, pero quizás 0.5 mm por 
encima de la flecha a lo largo del lado superior. Ajuste la calibración según el lado que esté fuera.  

• Una vez que el PNC es perfecto, anote estos valores X e Y en caso de que compre un nuevo equipo o 
tenga que reformatear su disco duro 

• Una vez que el PNC es perfecto, anote estos valores X e Y en caso de que compre un nuevo equipo o 
tenga que reformatear su disco duro. 

 

 

  

 

Si la línea de corte roja 
está por debajo de la 
línea de impresión 
negra, entonces 
disminuya el valor de X. 

Si la línea de corte roja 
está por encima de la 
línea de impresión 
negra, aumente el valor 
de X 
. 

Si la línea de corte roja está 
a la izquierda de la línea de 
impresión negra, aumente 
el valor de Y. (Nota: Y es 
un número negativo 
 

Si la línea de corte roja está 
a la derecha de la línea de 
impresión negra, entonces 
disminuya el valor de Y. 
(Nota: Y es un número 
negativo) 

La línea roja es más baja 
que la línea negra: 
cambie X de 0.3 a -0.7 
(nota: agregue el signo 
negativo)  

La línea roja es más alta 
que la línea negra: 
cambie X de 0.3 a 1.3 

La línea roja queda a la 
izquierda de la línea negra: 
cambie Y de -24.0 a -23.0 
(un aumento a un número 
negativo). 

La línea roja está a 1 mm a 
la derecha de la línea 
negra: cambie Y de -24.0 a 
-25.0 (una disminución a un 
número negativo). 

IMPORTANTE:  Cuando usted esté listo para probar este proceso en una imagen raster real, 
no olvide desactivar la opción Wireframe en File>Print Options. 
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9.05 Consejos Para Imprimir y Cortar 

• Cuando trace pixeles de imágenes importadas, las líneas de trazo no estarán necesariamente 
perfectamente alineadas con la imagen. Esto puede resultar en pequeños trozos de blanco que aparecen 
en ciertos puntos, lo que sugiere que la PNC no era precisa. Acercar cerca la imagen para que pueda ver la 
línea de seguimiento siguiendo el contorno de la imagen. Mire los mismos lugares donde la PNC no siguió 
la imagen perfectamente. Esto podría ser la causa de la PNC imprecisa. Hay tres maneras de lidiar con 
esta situación: 

 Vuelva a trazar la imagen importada, utilizando un ajuste Resample. Esto resultará en un ajuste más 
ceñido a la línea de trazado del gráfico original.  

 Utilice Node Editing y Segment Editing para mover las líneas de trazado para que se ajusten mejor al 
gráfico original. Esto se trata con detalle en la última parte de la Sección 7.13. 

 Cree una línea de inserción para usarla para cortar en lugar de la línea de trazado original. Esto se 
presenta en la Sección 9.06 - PNC con una Línea de Corte Insertada. 

• Si un PNC no es preciso y la causa no es la alineación de las líneas de trazado, entonces intente bajando 
la velocidad. Si el tapete se mueve varias veces, dentro y fuera de la cuchilla, puede producirse un ligero 
desplazamiento lateral, especialmente a altas velocidades. Intente disminuyendo Cut y Up Speeds. 

• Recuerde que la calibración del Desplazamiento láser (Laser Offset) es específica para el tipo de 
portacuchillas que se está utilizando. Por lo tanto, si usted cambia de marca, la calibración del láser tendrá 
que ser modificada.  

• Si su flecha de prueba está cortando perfectamente, indicando así que tiene la calibración correcta, pero su 
próxima impresión y corte está muy lejos, entonces tal vez su situación es algo fuera de lo común. Revise 
la siguiente sección que cubre diferentes escenarios en los que se necesitarán unos cuantos pasos 
adicionales al configurar las capas para su impresión y corte. 

• No es necesario establecer el origen ni siquiera poner la impresión en el tapete antes de iniciar el 

procedimiento PNC. ¡Mire este vídeo para una manera de hacer el proceso un poco más rápido!  
 
 
 

9.06 Escenarios de Impresión y Corte 
 

9.06.1 Cortar Múltiples Imágenes PNC en la Misma Página 
 

• Al realizar un PNC de varias imágenes (ya sea todas las imágenes iguales o imágenes diferentes), el 
procedimiento es el mismo. Se imprimirá un conjunto de cuatro marcas de registro a lo largo de los bordes 
exteriores del área delimitada de TODAS las imágenes de la página: 

https://vimeo.com/42564839
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9.06.2 PNC Con Una figura de Contorno Más Grande que la Imagen Impresa 

 

• En la Sección 9.01, se mostraron otras dos aplicaciones PNC. En un caso, se cortará un contorno exterior. 
En el otro, se añade una figura alternativa, tal como la figura de la etiqueta que se muestra a continuación. 

 

      
 

Añadir un Contorno 

• Usted desea añadir un corte de contorno y eliminar la línea de corte de la vaca, que se creó durante el 
trazado de píxeles, de modo que el único corte de línea será el contorno. Para hacer esto: 

 Seleccione la figura y utilice Shadow Function (la función Sombra) para añadir un contorno alrededor 
de su imagen. Consulte la Sección 8.05 para obtener instrucciones sobre el uso de esta función. 

 Asegúrese de que la imagen de trama (la vaca, en este ejemplo) esté en una capa más alta que la de 
la sombra a cortar. 

 Seleccione la imagen de vaca y la sombra y aplique la función Weld (soldadura) de Magic Toolbar 
(Barra de herramientas mágica). La línea de corte interna desaparece dejando la imagen de trama 
original ahora llenando Shadow Layer (la capa de sombra): 

 

PNC de múltiples 
imágenes en modo 
horizontal 
 

PNC de imágenes 
múltiples en modo 
vertical 

El contorno se añade 
usando Shadow Layer 

Se ha añadido la 
figura de etiqueta 

Imagen contorneada 
con sólo una sola 
línea de corte exterior. 

https://vimeo.com/43821153
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• El proceso de corte procede como se describe en la Sección 9.04. 

Añadir una Figura Alrededor de la Imagen 

• En el otro caso, con la figura de etiqueta añadida alrededor de la imagen original trazada, se puede usar el 
mismo proceso siempre y cuando la figura exterior sea blanca. Sin embargo, si se prefiere un fondo de 
color, entonces el proceso es un poco diferente: 

 Coloree la etiqueta, como desee. En este caso, la etiqueta es coloreada rosa: 

 

 Coloque la vaca dentro de la figura, asegurándose de que la vaca está visible. Luego, seleccione 
ambos y aplique la función Texture Snapshot en Magic Toolb (la Barra de herramientas mágica). Esto 
hace que la imagen de la vaca sea parte del relleno de textura de la etiqueta: 

 

• El proceso de corte procede como se describe en la Sección 9.04. 

 

9.06.3 PNC Con Una Figura de Contorno Menor que la Imagen Impresa 

 

• En esta situación, se va a cortar una figura que es más pequeña que los límites externos del gráfico 
importado. Por ejemplo, supongamos que se desea un borde festoneado como la línea de corte: 

    
 
 
 
 

Se va a añadir y a cortar un festón interior.   Imagen Original importada 

Desde las líneas de límite usted 
puede ver que hay dos figuras: 
la etiqueta de color rosa y la 
imagen de la vaca. La figura de 
la vaca se cortará si no está 
oculta.  

Luego de aplicar Texture 
Snapshot, solo hay una 
figura: la etiqueta con un 
relleno rosado, más la 
imagen de la vaca. La figura 
de la vaca no se cortará.  

https://vimeo.com/79411594
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• Como no se necesitará nada fuera del festón, esa parte será eliminada. Esto se hace primero ubicando el 
festón sobre la imagen y luego moviendo la capa del feston a su propia capa y al fondo en la barra de 
capas (Layers Bar): 

 

 

• Luego, seleccione ambos, la imagen original y el festón (o utilice Ctrl + A para Seleccionar Todo) y, luego, 
aplique la función Join de la Magic Toolbar. El festón ahora aparecerá en la parte superior: 

 

• Inmediatamente aplique la función Break desde Magic Toolbar (la Barra de herramienta Magica). La 
imagen original ahora aparece, pero con la figura del festón alrededor de ella: 

 

• Haga clic en otra parte de la pantalla para que no se seleccione nada. Luego, haga clic en la imagen y 
arrastre una imagen lejos de la otra: 

El Festón se mueve 
a la capa inferior 
para que esté 
detrás de la imagen 
original.   

Se añade y se 
alinea una figura de 
festón, según se 
desee.   
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• Ahora se puede borrar el original y duplicar la versión festoneada (si se desea) y realizar el proceso PNC, 
como es normal. 

 

9.06.4 PNC con una Figura de Contorno que se Superpone a la Imagen Impresa 

 

• Esta situación es similar a la anterior, sin embargo, en este caso, el festón se superpone a los bordes de la 
imagen impresa de tal manera que es más pequeña en una dirección pero más grande en la otra: 

 

 

• En este caso, se aplica el mismo método Join y Break como se mostrado en el ejemplo anterior. 
Asegúrese de que la figura del corazón se colorea como usted desea y está en la capa inferior. Después de 
aplicar las dos funciones, arrastre una figura lejos de la otra: 

 

 

 

• Una vista preliminar muestra que sólo se imprimirá el gráfico original. Observe cómo se imprimen las 
marcas de registro basado en el gran rectángulo blanco: 

Una figura de corazón debe ser agregada y cortada 
.   

Imagen original importada  
 

Ahora se puede 
eliminar este 
original 
.   

 
Nueva versión 
festoneada 

La imagen original importada 
se puede descartar u ocultar 
 

La figura está lista para PNC 

https://vimeo.com/43821152
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• Después de la impresión, proceda con el proceso habitual. 
 
 
 

9.06.5 PNC con una Línea de Corte Insertada 

 

• Esta situación puede parecer idéntica a la presentada en 9.06.3. La diferencia es que la línea de trazado 
original no será eliminada porque no es deseable eliminar partes de la imagen original. Mediante el uso del 
siguiente método, se introduce una asignación de sangrado. 

• Un trazado de píxel puede tener áreas donde la línea de trazado (línea de corte) estará fuera de la imagen 
original. Esto es especialmente cierto en las esquinas internas estrechas o en las curvas cerradas de la 
imagen. Esto produce áreas blancas que aparecen alrededor de la impresión y corte: 

 

 
 

• Al final de la Sección 7.13, se mostró cómo usar la edición de nodos y segmentos para corregir la línea de 
trazado para que se ajuste mejor a la imagen original. A veces, sin embargo, puede ser necesario editar 
más de lo que sería práctico hacer. En estos casos, se puede crear una línea de corte insertada. Mientras 
que el mismo método presentado en la Sección 9.06.3 podría ser utilizado, en este caso se desea tener lo 
que se denomina una asignación de sangrado (un margen de error para el corte), permitiendo que la 
imagen original más grande aún se imprima. 

• Seleccione la imagen trazada y acceda a la función Shadow Layer (Sombra de capa) de cualquiera de las 
siguientes maneras:  

 Haga clic en el icono Shadow Layer en Magic Toolbar   

 Presione Ctrl+H 

 Haga clic derecho en la pantalla y seleccione Shape Magic>Shadow Layer 

 Vaya a Edit>Shape Magic>Shadow Layer. 

• Seleccione el Shadow Width (Ancho de Sombra) deseado usando un número negativo para crear un 
recuadro. Tenga en cuenta que esto es normalmente menos de 0.03". Seleccione una opción Corner Join 
y consulte de nuevo la Sección 8.05 como referencia. Haga clic en Accept (Aceptar) cuando haya 
terminado. 

Las flechas rojas indican espacios 
alrededor de la oreja izquierda de 
nuestra vaca donde áreas blancas se 
mostrarían cuando se cortan. La línea 
original de trazado no encaja 
perfectamente con la imagen en esos 
puntos 
.  

https://vimeo.com/59272932
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• Por lo general, estas líneas de inserción están muy cerca de las líneas de traza originales y el corte de ambas 
líneas podría provocar problemas de corte, como rasgaduras o tiras finas de papel sueltas. Por esa razón, 
usted querrá desactivar las líneas de traza originales para que no se corten. Sin embargo, las marcas de 
registro están atadas a estas líneas de rastreo originales porque son más grandes que las nuevas líneas de 
inserción. Si usted simplemente apaga la capa original impresa cuando inicia el proceso PNC, la impresión y 
el corte no funcionarán correctamente. Pero, hay una manera fácil de hacer que esto funcione. 

• Mueva la nueva capa de línea de corte insertada a la parte inferior de la Barra de Capas para que esté 
detrás de la imagen original importada.  

• Añada un rectángulo blanco grande al proyecto. Si la página se va a llenar con varios objetos, entonces el 
rectángulo debe rodear todas las imágenes. Si sólo hay una imagen, entonces el tamaño del rectángulo 
puede ajustarse a esa imagen. Coloque en su propia capa y mueva a la parte inferior: 

 

 

 
Si hay varias imágenes: 

 

Observe cómo la nueva línea insertada 
se cortará claramente dentro de la 
imagen impresa para que no aparezcan 
áreas blancas alrededor del recorte. 

Un rectángulo es 
colocado alrededor de 
la imagen original y su 
inserción.  

Un rectángulo se 
coloca alrededor de 
todas las imágenes 
y sus inserciones. 

La imagen original debe 
estar en la capa superior 

Las imágenes originales deben 
estar en lacapa superior 

Inserción de Sombra  

Inserción de Sombras  

Rectángulo blanco 
circundante 

Rectángulo circundante 

Seleccione el tipo de Corner Join.  

Establezca Shadow Width (el ancho de sombra) 
deseado utilizando un número negative para crear 
una sombra insertada. 

   Haga clic en Accept cuando haya terminado.  
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• La capa rectangular debe estar encendida tanto para la impresión como para el corte. Debido a que la capa 
de sombra insertada se oculta detrás de las imágenes originales, esta también se puede dejar encendida 
para imprimir. Sin embargo, cuando esté listo para cortar, la imagen original debe estar oculta de manera 
que sólo el rectángulo circundante y la capa de línea de corte insertada se envíen a cortar.  

 

  
  

 
 
 
 

9.07 Imprimir y Cortar Sin Imprimir Desde MTC 
 
Las siguientes secciones cubren situaciones de PNC en las que no se realizará ninguna impresión desde MTC. 
 
 

9.07.1 Impresión Desde Otro Programa 
 

• A veces los usuarios prefieren diseñar e imprimir desde un programa de computadora diferente. En esta 
situación, el mejor curso de acción es agregar un rectángulo que completamente encierra las imágenes que 
se imprimirán y posteriormente se cortarán de MTC. Las cosas clave a recordar son: 
 

 El tamaño del rectángulo que se agregue debe ser un tamaño específico y anotado para que se pueda 
agregar un rectángulo idéntico en MTC. Los bordes de este rectángulo definirán las ubicaciones de las 
marcas de registro para el proceso PNC. 
 

 Si se utiliza un programa vectorial (por ejemplo, Adobe Illustrator, Corel Draw, Inkscape) y la(s) figura(s) 
es/son definida(s) en este programa, entonces, exporte ambos, el rectángulo y las figuras cortadas. 
MTC puede importar .eps, .ai, .pdf y otros formatos. Consulte el Capítulo 4 para obtener más 
información sobre la importación y exportación. Además, al usted importar el archivo, cambie el tamaño 
de todo al mismo tiempo, de manera que el rectángulo exterior coincida con el tamaño exacto que 
utilizó al crearlo. 

 

 Si se utiliza un programa de trama (por ejemplo, Elements, Word, Paint), entonces usted deberá 
escanear su impresión y luego utilizar la opción Pixel Trace (Trazado de píxeles) en MTC para importar 
la imagen de modo que las figuras de corte se puedan agregar al archivo. En este caso, cree un 
rectángulo exterior para que coincida con el escaneado, tanto en tamaño como en ubicación. Esto es 
importante porque el escáner puede haber escaneado en un tamaño ligeramente diferente y los 
resultados serán más precisos al hacer coincidir las dimensiones del rectángulo con lo que el escáner 
lee. 

 
 

9.07.2 Aplicaciones PNC con Imágenes Existentes  

 

• ¡Con MTC, incluso es posible hacer una impresión y cortar sin ninguna impresión implicada en absoluto! 
Dos de estas situaciones son: (1) Cortar las figuras que han sido dibujadas o estampadas a mano y (2) 
Cortar las imágenes impresas de una revista, calendario, periódico, etc. 

Todas las capas se dejan activadas 
para la impresión (aunque la capa de 
sombra es opcional) 

Desactive la capa de imagen original para el proceso 
PNC. Asegúrese de que se está mostrando la capa 
de sombra (corte de inserción), así como la capa de 
rectángulo 

Esconda 

https://vimeo.com/42691635
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• Al igual que en la sección anterior de Impresión Desde Otro Programa, lo único que se necesita es un 
rectángulo que se imprima o dibuje en la página que abarca las imágenes que usted desea cortar. Ese 
rectángulo podría ser preimpreso en hojas de papel o cartulina para usarse para estampar o dibujar 
imágenes o podría imprimirse en el papel/cartulina después de que las imágenes estén estampadas o 
dibujadas o incluso se podría utilizar un objeto rectangular para dibujar a mano los límites del rectángulo. 
Lo importante es que las esquinas sean ángulos rectos precisos. 

• Una vez que usted tenga el rectángulo en la página, escanee la imagen en MTC y Pixel Trace (Trazado de 
píxeles). Luego, gire las figuras, según sea necesario, de modo que las líneas del rectángulo estén 
perfectamente alineadas con la cuadrícula del Tapete Virtual. En otras palabras, asegúrese de que las 
líneas horizontales del rectángulo son perfectamente horizontales y las líneas verticales del rectángulo son 
perfectamente verticales. 

• Realice el proceso PNC como de costumbre. Las esquinas del rectángulo sirven como marcas de registro. 
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Expresiones de Gratitud 

 
 
 
Por favor, envíe un correo electrónico asandy@iloveknk.com si se encuentran errores en este manual o si 
usted tiene sugerencias de adiciones o cambios.  
 
Quisiera agradecer a las siguientes personas por las correciones a este manual. ¡Sin la ayuda de ellos, este 
manual estaría plagado de errores tipográficos! También aprecio enormemente sus cambios sugeridos para 
hacer las cosas más claras, más consistentes y más precisas: 
 
Ann Hunting 
Deb Manis 
Elisabeth Bier 
Laury Vaden 
Nelda Sturgill 
Ted Rauenbuehler 
Tom Maskus 
 
También quiero dar las gracias a las siguientes personas por el aporte técnico y/o videos: 
 
Liz Ackerman 
Andy Heinlein: http://www.make-the-cut.com/ 
Diane Hiscoe: http://scrapitcmh.blogspot.com/  
Maggie Hen: http://knkzingreview.com/ 
Michelle Hessler: http://www.paperthreads.com/ 
Brenda Josselet: http://www.digitalcuttersplus.com/  
Judy Keating 
Lynn Keniston 
Fred Muraca: http://www.skatkatz.com.au/ 
Joe Rotella: http://www.createncraft.com/ 
Rebecca Stewart 
Bryan Williams 
Chad Youngblut: http://knkusa.com/ 
 
¡Y un gran agradecimiento a mi familia y amigos por su paciencia y su apoyo por mi pasión Klic-N-Kut! 
 
Sandy McCauley 
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